Connecting Streamline Series VNA with
Thunderbolt 3 PC

Keysight Technologies 2022.08.19

* Host PC requirement

« Recommended PC list

* Troubleshooting for connecting
VNA and host PC
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Streamline Series VNA (B-model) Basic Setup

« Take advantage of powerful PC hardware (faster processor, better displays)
* No data storage memory on VNA. Well-suited for classified environment
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Thunderbolt 3 cable
(with USB Type-C
connectors)

Power

Streamline
Series
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Consideration of Host PC for P93xxB
e Requires 64-bit Windows 10 OS and Thunderbolt 3 with USB Type-C interface

e [tis recommended to install the latest version of BIOS, Thunderbolt 3 controller
firmware and driver, or Windows OS before launching VNA firmware with P50xxB
or P93xxB.

« See PC list verified by Keysight (next page)

« USB2.0 or 3.0 connection is not supported.

e Connection via USB3.0-to-Thunderbolt 3 adapter is not supported.
 Thunderbolt 4 connection is supported.

* Windows 11 (64-bit) is supported.

Host PC requirements

PC System Requirement

Operating Systems Windows 10 (64-bit) Version 1909 or later
Available Memory 16 GB recommended, 4 GB minimum
Available Disk space 2 GB available disk space minimum
Display resolution 1024 x 768 minimum

Connection with VNA Thunderbolt 3, Thunderbolt 4
Recommended CPU Intel Core i7 10" Generation or later
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Thunderbolt 3 Host PC and VNA compatibility list

Single VNA Single VNA
Thunderbolt # of & g Two VNA  Two VNA

os operation operation operation operation Verified

PC Maker PC model name CPU Gen - Code name CPU i . Controller Thunderbolt3 i
Microsoft Windows (lmodule  (2modules (star (daisy by

chipset) Gen connectors
(chipset) model)**  model)®' topology) topology)

Laptop/Mobile workstation

Dell Precision 5530 8" Gen - Coffee Lake Intel Core i7-8850H Windows 11 Professional (x64) 1.24.0, 3/21/2022 15D9 1 Pass Pass N/A Pass . Keysight
Dell Precision 5550 10" Gen - Comet Lake Intel Core i7-10750F Windows 10 Professional (x64) 1.6.1, 1/14/2021 15EB 2 Pass Pass Pass Pass Keysight
Dell Precision 7550 10" Gen - Comet Lake Intel Core i7-10850F Windows 10 Professional (x64) 1.5.1, 11/25/2020 15EB 2 Pass Pass Pass Pass Keysight
HP EliteBook 830 G6 8" Gen — Whiskey Lak Intel Core i5-8365U Windows 10 Professional (x64) R70 Ver 01.12.20 15EB 1 Pass not tested N/A not tested Keysight
HP EliteBook 830 G7 10" Gen - Comet Lake Intel Core i5-10210U Windows 10 Professional (x64) 15EB 2 Fail not tested not tested not tested end usel
HP EliteBook 840 G6 8" Gen — Whiskey Lak Intel Core i5-8365U Windows 10 Professional (x64) R70 Ver.01.20.00, 5/10/2027 15E8 1 Pass Pass N/A Fail Keysight
HP EliteBook 840 G7 10" Gen - Comet Lake Intel Core i5-10310L Windows 10 Professional (x64) S70 Ver.01.09.00, 5/10/202Z 15EB 1 Pass Pass N/A Pass Keysight
HP ZBook 15 G4 7" Gen - Kaby Lake Intel Core i7-7028H(Windows 10 Professional (x64) P70 Ver.01.41, 4/29/2022 15EB” 2 Pass not tested not tested not tested Keysight
HP ZBook 15 G5 8" Gen - Coffee Lake Intel Core i7-8850H Windows 10 Professional (x64) Q70 Ver 01.19.00, 1/27/202:15EB 2 Pass Pass Pass not tested Keysight
HP ZBook 15 G6 9™ Gen - Coffee Lake Intel Core i9-9880H Windows 10 Professional (x64) R92 Ver 01.20.00, 3/23/2022 15EB 2 Pass Pass Pass Pass Keysight
HP ZBook Studio G7 10" Gen - Comet Lake Intel Core i7-10750F Windows 10 Professional (x64) S91 Ver.01.90.00, 5/10/202Z 15EB 2 Pass Pass Pass Pass Keysight
HP ZBook Firefly 14 G7 10" Gen - Comet Lake Intel Core i7-10810L Windows 10 Professional (x64) S70 Ver.01.09.00, 4/7/2022 15EB 2 Pass Pass Pass Pass Keysight
Lenovo ThinkPad P52 8" Gen - Coffee Lake Intel Core i7-8750H Windows 10 Professional (x64) N2CET63W (1.46), 3/23/202 15EB 2 Pass Pass Pass Pass Keysight
Lenovo ThinkPad P53 9" Gen - Coffee Lake Intel Core i7-9850H Windows 10 Professional (x64) N2NUJ21W (1.36), 3/30/202 15EB 2 Pass Pass Pass Pass Keysight
Lenovo ThinkPad X1 Carbon Ge 10" Gen - Comet Lake Intel Core i7-10510L Windows 10 Home (x64) N2WUJ22W (1.26), 4/27/20215D2 2 Pass not tested not tested not tested end usel
LG gram 14Z90N-VR51J 10" Gen - Ice Lake  Intel Core i5-1035GWindows 10 Home (x64) C2ZE0210 X64, 02/02/2022 8A17 1 Pass Pass? N/A not tested end usel
LG gram 15ZB95N 11" Gen - Tiger Lake Intel Core i5-1135G7Windows 10 Enterprise (x64) 9A1B 1 not tested Falil N/A not tested end usel
PanasonitCF-LV8RD7VS 8" Gen — Whiskey Lak Intel Core i5-8365U Windows 10 Professional (x64) 15D9 1 Pass not tested N/A not tested end usel
Toshiba Dynabook UZ63/L 8" Gen — Whiskey Lak Intel Core i7-8565U Windows 10 Home (x64) 2 Pass Pass not tested not tested end usel
Note:

A 1 module model: P93xxB, P500xB, P5020B-400/600, P5021B-400/600, P5022B-400/600, P5023B-400/600, P5024B-400/600

® 2 modules model: P5020B-402, P5021B-402, P5022B-402, P5023B-402, P5024B-402, P5025B, P5026B, P5027B, P5028B

! English OS can work correctly, but Simplified Chinese OS/Traditional Chinese OS cannot work correctly. (Hot plug-infout of VNA is not working correctly)
2 |f PC cannot detect 2 modules model with Code12 error in Device Manager, a registry change is required.

" Thunderbolt Controller chipset driver was copied from Zbook 15 G5.
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Thunderbolt 3 Host PC and VNA compatibility list

Single VNA Single VNA Two VNA  Two VNA
Thunderbolt # of g 4 wo Wo

operation operation i i ifi
PC Maker PC model name CPU Gen - Code name CPU 0s Controller Thunderbolt3 g . operation  operation  Verified

Microsoft Windows (lmodule  (2modules (star (daisy by

chipset) Gen connectors
(chipset) model)®®  model)®* topology) topology)

Dell Precision 5820 Tower 6" Gen - Skylake Intel Xeon W-2135 Windows 10 Professional (x64) 2.19.1, 4/5/2022 15D2 3 2 Fail Fail Fail Fail - Keysighf
HP Z1 G8 Tower 11" Gen - Rocket Lak Intel Core i9-11900 Windows 11 Professional (x64) TO1 Ver. 02.08.00, 4/14/202;1134 1 Pass Pass N/A not tested Keysighf
HP Z2 G8 Tower 11" Gen - Rocket Lak Intel Xeon W-1370 Windows 10 Professional (x64) T50 Ver. 01.04.02, 3/17/202;1134 2 Pass Pass not tested not tested Keysight
HP Z4 G4 6" Gen - Skylake Intel Xeon W-2123 Windows 10 Enterprise (x64) P61 Ver,02.74 7/6/2021 15D2 4 2 Pass®®  Pass®®  Fall Fail Keysight
HP 76 G4 6" Gen - Skylake Intel Xeon Silver 411Windows 10 Professional (x64) P60 Ver.02.78, 1/20/2022 15D2 * 2 Pass®  Pass®  Fall Fail Keysight
Mini-PC

Asus PN62 10™ Gen - Comet Lake Intel Core i7-10710L Windows 11 Home Single Lang 1005, 12/16/2021 15BF 1 Fail Fall N/A Fall Keysight
Dell Optiplex 7070 9" Gen - Coffee Lake Intel Core i7-9700 Windows 10 Professional (x64) 1.13.0, 3/22/2022 15D2 2 Pass Pass not tested not tested Keysight
HP Z2 G8 SFF 11" Gen - Rocket Lak Intel Core i5-11500 Windows 11 Professional (x64) T50 Ver. 01.04.02, 3/17/202;1134 1 Pass Pass N/A not tested Keysight

Note:

A 1 module model: P93xxB, P500xB, P5020B-400/600, P5021B-400/600, P5022B-400/600, P5023B-400/600, P5024B-400/600
B 2 modules model: P5020B-402, P5021B-402, P5022B-402, P5023B-402, P5024B-402, P5025B, P5026B, P5027B, P5028B
! English OS can work correctly, but Simplified Chinese OS/Traditional Chinese OS cannot work correctly. (Hot plug-in‘out of VNA is not working correctly)
% Requires PCle card, ROMNS. Other PC maker’s PCle card is not compatible.
* Requires PCle card, 3UUOSAA. Other PC maker’s PCle card is not compatible.
®> 15D2 is unstable to communicte with P50xxB/P93xxB.
® Known issues: (1) Only Port-A of Controller PC can communicate with P50xxB/P93xxB, due to PCle resource limitations.
(2) 2m/40Gbps Thunderbolt 3 active cable cannot communicate with P50xxB/P93xxB both on Port-A and on Port-B.
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Thunderbolt 4 Host PC and VNA compatibility list

PC Maker

PC model name

Laptop/Mobile workstation

Acer
Asus
Dell
Dell
Dell
Dell
Dell

Lenovo
Lenovo
Lenovo
Lenovo
Lenovo
Desktop
Dell

Mini-PC
Dell

Intel

Swift SF314-511
ZenBook UX425EA
Latitude 5320

Latitude 5520

Latitude 7520

Precision 3560
Precision 3561

Elite x2 G2 Tablet
EliteBook 840 Aero G8
EliteBook 850 G8
ProBook 650 G8
Spectre x360 Conpartible 15-eb
ZBook Power 15.6 G8
ZBook Power 15.6 G8
Zbook Power 15.6 G9
ThinkBook 14 Gen2 ITL
ThinkBook 15 Gen2 ITL
ThinkPad L15 Gen2
ThinkPad P15s Gen2
ThinkBook14s Yoga ITL

Precision 3650 Tower

Optiplex 7090 Ultra UFF
NUC11TNHi5

Note:

CPU Gen - Code name

11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
12" Gen - Alder Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake
11" Gen - Tiger Lake

11" Gen - Rocket Lake

11" Gen - Tiger Lake
11" Gen - Tiger Lake

Intel Core i5-1135G7
Intel Core i5-1135G7
Intel Core i7-1185G7
Intel Core i7-1165G7
Intel Core i7-1185G7
Intel Core i7-1185G7
Intel Core i7-11850H
Intel Core i7-1165G7
Intel Core i7-1165G7
Intel Core i7-1165G7
Intel Core i5-1135G7
Intel Core i7-1165G7
Intel Core i7-11850H
Intel Core i7-11850H
Intel Core i7-12800H
Intel Core i5-1135G7
Intel Core i5-1135G7
Intel Core i5-1135G7
Intel Core i7-1165G7
Intel Core i7-1165G7

Intel Core i7-11700

Intel Core i5-1145G7
Intel Core i5-1135G7

(01
Microsoft Windows

Windows 10 Home (x64)
Windows 10 Home (x64)
Windows 11 Professional (x64)
Windows 10 Professional (x64)
Windows 11 Professional (x64)
Windows 10 Professional (x64)
Windows 10 Enterprise (x64)
Windows 11 Professional (x64)
Windows 10 Professional (x64)
Windows 10 Professional (x64)
Windows 10 Professional (x64)
Windows 11 Professional (x64)
Windows 11 Professional (x64)
Windows 10 Enterprise (x64)
Windows 10 Enterprise (x64)
Windows 10 Home (x64)
Windows 11 Professional (x64)
Windows 10 Enterprise (x64)
Windows 10 Professional (x64)
Windows 11 Professional (x64)

Windows 11 Professional (x64)

Windows 10 Professional (x64)
Windows 11 Enterprise (x64)

Version 309, 12/25/2021
1.5.1, 4/12/2022

1.18.1, 5/9/2022

1.4.4, 3/9/2021

1.18.1, 4/14/2022

1.11.1, 4/14/2022

T91 Ver.01.04.00, 5/18/2021
T76 Ver.01.09.01, 5/24/2022
T76 Ver.01.08.20, 3/11/2022
T72 Ver.01.09.01, 5/13/2022
AMI F08, 7/26/2021

T81 Ver.01.09.02, 5/5/2022
T81 Ver.01.09.02, 5/5/2022
U97 Ver.01.01.10, 4/28/2022
F8CN47WW (V2.10), 4/8/2022
F8CN47WW (V2.10), 4/8/2022
R1JET55W (V1.55), 2/28/2022
N34ET50W(1.50), 4/8/2022
FNCN38WW, 4/25/2022

1.11.0, 4/18/2022

1.10.0, 4/19/2022
0064, 2/17/2022

Thunderbolt  # of
Controller
(chipset) Gen

9A1B
9A1B/9A1D
9A1B
9A1B
9A1B
9A1B
9A1F
9A1B
9A1B
9A1B
9A1B
9A1B
9A1F
9A1F
463E
9A1B
9A1B
9A1B
9A1B/9A1D
9A1B

1137

9A1D
9A1B/9A1D

A 1 module model: P93xxB, P500xB, P5020B-400/600, P5021B-400/600, P5022B-400/600, P5023B-400/600, P5024B-400/600
® 2 modules model: P5020B-402, P5021B-402, P5022B-402, P5023B-402, P5024B-402, P5025B, P5026B, P5027B, P5028B
. English OS can work correctly, but Simplified Chinese OS/Traditional Chinese OS cannot work correctly. (Hot plug-in/out of VNA is not working correctly)
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2 |f PC cannot detect 2 modules model with Code12 error in Device Manager, a registry change is required.

Thunderbolt4
connectors

RPN R P EPERPRPNNRERNMNDMNODNNODNNNNNR

Single VNA
operation
(Imodule
modeI)A’1

Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass
Pass

Pass

Pass
Pass

Single VNA
operation
(2modules
modeI)B'1

not tested
not tested
Pass
Pass

not tested
Pass
Pass
Pass?
not tested
Pass

not tested
Pass?
Pass
Pass?
Pass?

Fail

Pass?
Pass?
Pass’

not tested

Pass

Pass
Pass’

Two VNA
operation
(star

topology)

N/A
not tested
not tested
not tested
not tested
not tested
not tested
not tested
not tested
not tested
N/A
not tested
not tested
N/A
N/A
N/A
N/A
N/A
not tested
N/A

not tested

N/A
Pass

Two VNA
operation
(daisy

topology)

not tested -
not tested .

not tested
not tested
not tested
not tested
not tested
not tested
not tested
not tested
not tested
not tested
not tested
not tested
Pass?

not tested
not tested
not tested
not tested

not tested -

not tested

not tested
Pass’

Verified by

end user
end user
Keysight
Keysight
end user
Keysight
Keysight
end user
end user
Keysight
end user
end user
Keysight
Keysight
Keysight
end user
end user
Keysight
Keysight
end user

Keysight

Keysight
Keysight



Troubleshooting — Connection of Host PC and VNA

o If Streamline Series VNA (P93xxB or P50xxB) is not connected with PC
correctly, confirm the followings:

Is your VNA identified with Thunderbolt Control Center?

What is revision of Thunderbolt Control Center?

Is your VNA identified with Device manager?

Is your VNA identified with Keysight Connection Expert?

What is the model number of your host PC?

Do you use the latest version of VNA firmware and Keysight 1O Libraries?

Are the latest BIOS revision, Thunderbolt firmware and Thunderbolt driver
Installed with PC?

|s Kernel DMA Protection disabled?
Is Windows 10 Fast Startup disabled?
10. Is Thunderbolt 3 PCle Hot plug mode in BIOS (UEFI) correctly set?

11. Is Interconnect cables for LO or control signals at VNA front panel
connected properly?

No abkobdPE

o

©
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1. Is your VNA identified with Thunderbolt Contrbl Center?

Thunderbolt™ Contrel Center — O x
. . " ” H 3 2=
Attached Thunderbolt™ devices « If VNA s connected correctly, “P600x” (chassis of Streamline
— Series VNA) will be shown.
€2 Attached Thunderbolt™ Devices — | x
Attached Devices Chains
Port 2 4 Thunderbolt™ Controller 1
Port 1
4 Port 2
Keysight Technologies, P600X
Device Information
Device Info Name: Keysight Technologies, PE00X
Name: Keysight Technologies, PEO0X Vendor: Keysight Technologies
Vendor: Keysight Technologies
Model: PGO0X Model: PE00X
Power mode: Self power Connection Status: Connected
Connection Status: Connected Power Mode: Self Power
KEYSIGHT . - 8
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2. What is the revision of Thunderbolt Control Center?

All Apps Documents Settings

Best match

" Thunderbolt™ Control Center
App

Apps

Photos

2 thunder

KEYSIGHT
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More +

i

7

Thunderbolt™ Control Center

App

) Open

<9 Pin to Start

<3 pin to taskbar
£ App settings
3= Rate and review

|2 Share

]E Uninstall

 Type in “Thunderbolt..” in the Windows search bar

» Select “Thunderbolt Control Center” to launch

e Click three-bar icon and identify the revision of
Thunderbolt Control Center

Thunderbolt™ Control Center — m] X
ached Thunderbolt™ devices
0

Device Info

MName: Keysight Technologies, PG00X
Vendor: Keysight Technologies
Model: PE00X

Power mode: Self power

Connection Status: Connected




2. What is revision of Thunderbolt Control Center?

e Click “About”
 Check Thunderbolt generation and NVM
Firmware (Thunderbolt firmware) version

Thunderbolt™ Control Center

p ; . .
R ERar s durices device shown in dialog.
Attached devices
Ex1.) Ex2)
Manage approved devices .
/ Thunderbolt™ Control Center = (m] * Thunderbolt Control Center = O X
Details Details
™
H & Thunderbolt™ Software Thunderbolt™ Software
3 Application version: 1.0.32.0 Application v‘er5|on: : 10239
S e O 1.41.914.0 Controller driver version: 1.41.1030.0
: —_— Kernel DMA Protection Status: How to check
Thunderbolt™ Controller 1 PCIE tunneling: Enabled
Thunderbolt™ generation: Thunderbolt 3 (15EB) Thunderbolt™ Controller 1
Numl?er of ports: & " Thunderbolt™ generation: Thunderbolt 4 (9A1B)
Security Level: Kernel DMA Protection Number of ports:
NVM Firmware version: 62.0 NVM Firmware version:

Tips:

NVM Firmware version should be updated to the latest version by

using a tool provided by PC vendors.

For example, drivers of HP EliteBook Series can be updated by HP
TeEhoLonty Support Assistant on HP.com.



https://support.hp.com/us-en/drivers/selfservice/hp-elitebook-840-g6-notebook-pc/26609796?ssfFlag=true&sku=

2. What is revision of Thunderbolt Control Center?

Ex.) HP Support Assistant for HP EliteBook

1. Go to HP site (link) to download “HP Support Assistant”
2. Right-click the saved *.exe file and select “Run as administrator”

Open

] G Run as administrator
Troubleshoot compatibility
Pin to Start

Ruin Flavatad

@ HP Support Assistant
N nop

Install HP Support Assistant with your host PC
Launch HP Support Assistant

Update Thunderbolt firmware, Thunderbolt driver, and BIOS of your
PC to the latest version

o &~
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https://support.hp.com/us-en/drivers/selfservice/hp-elitebook-840-g6-notebook-pc/26609796?ssfFlag=true&sku=

2. What is the revision of Thunderbolt Control Center?

je thunderboltl!
‘) Thunderbolt™ Software

App Alternatively, for other PC with different software
version,

9 e Launch Thunderbolt Software
Thunderbolt™ Software Vo Ariached Daieas * Right click on the system tray icon, click “About”
ofre package ersion: 1A Approve Attached Devices » « Check Thunderbolt generation and NVM Firmware
Application version: 17.479.16 Thunderbolt™ Networking . . . 0
e verson: 1747013 e Dt (Thunderbolt firmware) version shown in dialog.
Controller driver version:  17.4.79.11 SEiingS

o _ About |

Networking driver version: Unknown Exit E

Thunderbolt™ Controller

Thunderbolt™ generation: Thunderbolt 3 (15D9)
Number of ports: 1

Security Level: User Authorization (SL1)
NVM Firmware version: 46.00

External GPUs supported: Yes

KEYSIGHT
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3. Is your VNA identified with Device manager?

6

(Scenario #1)

£ device ma nagerl

Best match

? Device Manager

ar
Control panel

% Device Manager

File Action View Help

= @ E Hdm =

v i piccolo04
uetooth

... Keysight Technologies Modular Devices
= P50xxB/P93xxB

2 P600X Chassis

= Ry -
iy Audio inputs and outputs
% Batteries

)| Biometric devices

9 Bluetooth

@ Cameras

aln R T Y R BT I

KEYSIGHT
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Type in “device manager” in the Windows search bar
to launch Device Manager

Confirm “P50xxB/P937xB” or “P600X Chassis” are
shown in Device Manager.

Tips:

If the model number of VNA (ex. P50xxB/P93xxB)
and chassis (ex. P600xB) do not appear in Device
Manager, BIOS, Thunderbolt firmware, or
Thunderbolt driver with the host PC must be updated
to the latest version.



Is your VNA identified with Device Manager?
(Scenario #2)

F”t:c?:"| |.-1"-r:i|TEH:If =  Check Properties of P50xxB/P93xxB if “I" icon below
= g 012 psomue/ps308 Properies X is shown on your P50xxB/P93xxB.

. i Audio inputs and outpu General Driver Detals Events Resources

_), IIICIc-mpL]ter M P5bB/PI30B @ P50‘XKBXP93}(}(B ‘

== Disk drives
. B8l Display acapters

» m OVD/CD-ROM drives Device type: Keysight Technologies Madular Devices
- M Firmware ] Marufacturer: Keysight Technologies
IV LB EaTecR e Location PCI Slot 4 (PC1 bus 89, device 0, function 0)
» =1 Keyboards
v 1 Ke:.fsrght Technnlcguesh e T|pS
48 cepce coneict Il eri es esounesa e X con . This icon appears when the host PC cannot allocate
- Eﬂﬂf 0wt o deie you e detle e e enough Kernel memory resources for PCle
d Br QevVICes on &m, . . . . -
QE P&W: ct:m.-.;_ t_ communication within VNA. (VNA firmware cannot
v ICE and Other poin mg . .
, @ Monitors recognize the VNA).
» P Network adapters
6 fomthon gl To avoid the issue:
» 7 Print queues 1. Disconnect the second VNA (for two-VNA
p P
> ?s;:::f:r:mmts operations) or
[l Software devices. [ ok ]| cance 2. Use another PC in the support list

KEYSIGHT : . 14

TECHNOLOGIES



Is your VNA identified with Device Manager?
(Scenario #3)

A + For P502xB/ P938xB of 4-port, 2 independent VNA
N T modules configuration (Opt 402 for < 20GHz, Opt

& 5 |j o) @ P50xxB/P93xxB Properties X
- . - 400 for = 26.5GHz), one of the two VNA modules

4wt sns oy RO | D | Dotele | Evors | Racoumoss might not be correctly recognized in certain
8 bomccovices | D POem controller PCs as shown.
g p— Device type:  Keysight Tachnologiss Modulr Devices e The other module of the same box is correctly
[ Computer Manufacturer: Keysight Technologies recognlzed .
wa Disk drives Location: PCI Slot 1 (PCI bus 82, device 0, function 0) iy .
@ Display adapters v Ke Sght TeChnOIJIQS |
* Firmware Device status

W Human Interface Device '|"I'his device cannot find enough free resources that it can use. 'A pSOXXB/p93XXB I

== Keyboards (Code 12) m%m{m@ =

” %s&ht_l’ec_l‘urml%le‘s If you want to use this device, you will need to disable one of the
witl PSO0B/PI30B other devices on this system. P600X Chassis
7B /P30

&2 P600X Chassis Ti p-SZ.
£ Memory technology dg This icon appears when the host PC cannot allocate

u Mice and other pointin

gmmrs enough Kernel memory resources for PCle
Network adapters

= Print queues communication within VNA. (VNA firmware cannot
[ Processors . .
} TOcesSOfs recognize the VNA).

B Security devices Cancel
¥ software components
B Software devices

KEYSIGHT
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3. Is your VNA identified with Device Manager?

(Scenario #3)

All Apps Documents Settings More ¥

Best match
Command Prompt
App
Apps
Command Prompt
App

] Open

T Run as administrator
0 Open file location
= pin to Start

= Ppin to taskbar

Microsoft Windows [Version 10.0.19044.1706]

C:\Users)\ 1>cd desktop

C:\Users)\ \Desktop>

KEYSIGHT
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(c) Microsoft Corporation. All rights reserved.

Ic: \Usersh \Desktop>reg import TH_PCIE.reg
The operation completed successfully.

To resolve this issue, registry update is required.

TN, §,

TH_PCIE zip

Note: The following steps are to be performed at end user’s own risk.

1. Backup the current registry. Launch Registry editor (regedit), select File> Export.
Select ALL for Export Range. Enter file name (example original_reg_21June22.req)

and click save.

2. Download and unzip the TH_PCIE.reg registry patch to controller PC the VNA is

connected to.

3. Launch Command Prompt in Administrative mode (Run as Administrator).

4. Navigate to the folder the registry file is saved to. Execute the patch with “reg import

TH_PCIE.reg” command.

5. Launch Registry Editor. Ensure the HackFlags value is successfully added to the
following \HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\PnP\Pci

i.. Reqistry Editor
File Edit View

Favorites Help

Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\PnP\Pci
V - PnP ~ || Name Type Data
.~ Busnformation ab| (Default) REG_SZ (value not set)
v PCiC i %4/ DisableExternal DMAUnderLock | REG_DWORD 0x00000000 (0)
L0 cardlis

i Registry Editor

File Edit View Favorites Help er
Computer,\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\PnP\Pci
\:' - PnP ~ || Name Type Data
; Buslnformation ab| (Default) REG_SZ (value not set)
Y i -1 Q45301 20 DMAURGEILOCK. e REGDWORD . o L0000 — —
: o ‘.‘:.'.%EI—_!ac_IgFIag% REG_DWORD 0x00100000 (10485?6)|



https://www.keysight.com/my/en/assets/9922-02069/miscellaneous/TH-PCIE.zip

3. Is your VNA identified with Device Manager?

Scenario

Thunderbolt™ Control Center

Attached Thunderbolt™ dev

Port 1

7

Port 2

#4)

Thunderbolt™ Control Center — O X

Approve Thunderbolt™ devices

The following Thunderbolt™ device chain has been plugged in and
one or more devices require your permission to connect to this
system.

Select the devices you wish to connect:

Device Info

MName: Keysight Technalg
Vendor: Keysight Technolg
Model: Pe0O0X

Power mode: Self power

Port 1
Connect only once

Always connect :

Do Not Connect

Keysight Technologies, P600X

Connection Status: 1

Connected 1

KEYSIGHT
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OK

« In TBT Approved Thunderbolt Device list,
select “Always Connect”.

¢# Attached Thunderbolt™ Devices

Attached Devices Chains

- O X

4 Thunderbolt™ Controller 1
4 Port1
¢ Keysight Technologies, P600X

Device Information

MName: Keysight Technologies, P&00X
Vendor: Keysight Technologies

Maodel: PeOOX

Connection 5Status: Connected

Power Mode: Self Power

9 Approve Thunderbolt™ Devices - X

The following Thunderbolt™ device chain has been plugged in and one or more devices
require your permission to connect to this system.

Select the devices you wish to connect:

Keysight Technologies, P600X : T Seeren vl

Note: Selecting "Do Not Connect” will prevent that device and all devices further down
the chain from being used on the system.
Install the driver included with the device before approving the device.
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4. Is your VNA identified with Keysight Connection Expert?

Apps Documents Settings Email I

Best match -
| 2 keysight connection expe o . . -
q Y Keysight Connection Expert . e Type In Keysight connection expert” in
App the Windows search bar to launch

Keysight Connection Expert.
o Confirm “P50xxB/P937xB” or “P600X
Keysight Connection Expert 2021 Chassis” are shown in Device Manager.

Instruments PXI/AXIe Chassis

rn o= . ; .
My Instrumen ts +Add T 2 Y Details for Keysight Technologies P600SA
ez x B @ & -
v USB (USBO) L ¥4 % — — O
o ) Check Edit Remove Interactive IO Monitor Command BenchVue  Web Ul Soft F
Status 10 Expert Pan
v PXI (PXI0) ) )
Manufacturer: Keysight Technologies
P6005A, Keysight Technologi Model: i
PXI0::1::BACKPLANE Identify Chassis

P5004B, Keysight Technologie
Chassis: 1, Slot: 1

P6005A, Keysight Technologies VISA Address Aliases
PXI0::2::BACKPLANE
b Ql PXIO::1::BACKPLANE :ll

Connection Strings

ot

KEYSIGHT

TECHNOLOGIES



4. Is your VNA identified with Keysight Connection Expert?

Successfully connected Connection failed
- - M
No Instruments Found
L
;| -
P6006A, Keysight Technologies
PXI0::1::BACKPLANE
e Wght Technologies
Chassis: 1, Slot: 1
Ex.) P5028B
Opt.402
P5028 eysight Technologies Modu
assis: 1, Slot:
Ch
Bu
ﬁ P6006A, Keysight Technologies .
o “P50xxB/P93xxB” (VNA model number) is
“P600BA” (Chassis model number) « “P6006A” (Chassis model number) is
should be displayed under “PXI (PXI0)". ~ Shown UnaeiRBARCAESE
« “P50xxB” should be displayed with Tips: _ _ _
“Chassis’ 1. Slot x". If displayed with Keysight Connection Expert: :
’ 1. Reboot host PC. | oAl P50xxB/P93xxB
A - 2. Check “I" mark is shown in Device Manager

TECHNOLOGIES (See Tips in 3.Is your VNA identified with Device Manager?).



5. What is the model number of your host PC?

Check if your host PC is included in Thunderbolt x Host PC and VNA compatibility list.
If yes, try to use a PC in the compatibility list.

6. Do you use the latest version of VNA firmware and
Keysight IO Libraries?

PXle/USB Vector Network Analyzer Firmware Update (64 bit)

|O Libraries Suite Downloads | Keysight

KEYSIGHT
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https://www.keysight.com/us/en/lib/software-detail/instrument-firmware-software/pxieusb-vector-network-analyzer-firmware-update-64-bit-3027357.html
https://www.keysight.com/us/en/lib/software-detail/computer-software/io-libraries-suite-downloads-2175637.html

8. Is Kernel DMA Protection disabled?

The Kernel DMA Protection feature of Windows 10 may cause errors in Device Manager for modules.
For more information on how this works and how to prevent it, please refer to the following document
from Microsoft and configure it appropriately https://docs.microsoft.com/en-
us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt

KEYSIGHT
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https://docs.microsoft.com/en-us/windows/security/information-protection/kernel-dma-protection-for-thunderbolt

9. Is Windows 10 Fast Startup disabled?

Run X

Type the name of a program, folder, document, or
Internet resource, and Windows will open it for you.

Open: ‘ powerr:fg.r:pl| "

Cancel Browse...

3B Power Options - O
= v 4 3 » Control Panel » All Control Panel lterns » Power Options v O Search Control Panel
File Edit View Tools Help
Control Panel Home .
Choose or customize a power plan
Choose what the power A power plan is a collection of hardware and systemn settings (like display brightness, sleep, etc.) that manages
buttons do how your computer uses power, Tell me more about power plans
Create a power plan Preferred plans
Qe g.holosewhen to turn off the (O Balanced (recommended) Change plan settings
spiay Automatically balances performance with energy consumption on capable hardware.
W Change when the computer
sleeps (@ High perfermance Change plan settings
Favors performance, but may use more energy.
Show additional plans
Seealso
Persenalization
User Accounts
0 items E Computer

YWV TEcHNoLoGIES

Press Windows key + R to bring up the run
dialog. Type in “powercfg.cpl” and click “OK” to
launch “Power Options”

Click “Choose what the power buttons do” from
the menu on left.



9. Is Windows 10 Fast Startup disabled?

@ Systern Settings

&« v E » Control Panel » All Control Panel ltems » Power Options » System Settings v | O Search Control Panel

File Edit View Tools Help

0 items

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans.

Power and sleep button settings

0 ‘When | press the power button: | Shut down b

@ ‘When | press the sleep button: Sleep s

Shutdown settings

[]Turn on fast startup (recommended)
This helps start your PC faster after shutdown. Restart isn't affected. Learn More

[]Sleep
Show in Power menu.

[ Hibernate
Show in Power menu.

Lock

Show in account picture menu.

Save changes Cancel

E Computer

KEYSIGHT
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Scroll down to show “Shutdown settings” and
uncheck the box of “Turn on fast startup”.

Note: if these option are greyed out then you
may need to click “Change settings that are
currently unavailable”.

; System Settings

& v 1T % « Power Options » System Settings v O

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you ma

I!;J Change settings that are currently unavailable I

Power and sleep buttons and lid settings




10. Is Thunderbolt 3 PCle Hot plug mode in BIOS
(UEFI) correctly set?

Access to the BIOS (UEFI) settings page. In Thunderbolt

PCle Hot plug mode, select “Native + Low Power Mode”.

) ) USB Chassis FPGA Update Needed X
Shown is the HP BIOS settings example. =R PR
Would you like to update the FPGAS now?
- Note: if it is set to “Legacy Mode”, USB Chassis FPGA update :mmzm"m'
will take a long time and fail to complete.
Update FPGA Cancel

W] VNA Parser

|Advanced | UEFI Drivers

VNA Parser has encountered a problem and needs to close. We are
sorry for the inconvenience.

Please tell us about this problem.

We have created an emor report that you can send to help us improve VNA Parser. We wil
treat this report 8 confidential
10

Contact information (all fields optional):

The contact information will only be used for the purpose of contacting you for more
information about this emor f necessary. ¥ you choose not to provide contact information,

this report will be completely anorymous
Name: || | Emat: |
muMMIS&:uriWLwﬂ : \M\lmmdwrgﬂmhmm?
Mle and Disnlax — - <Add arry stepa to reproduce thes problem here
PCle and DisplayPort - User Authorization © "
A
Cle ~ 2 Send Emor Repot | Dont Send

KEYSIGHT
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10. Is Thunderbolt 3 PCle Hot plug mode in BIOS
(UEFI) correctly set?

Additional information related to Q3 Is your VNA identified with Device Manager?
« To pre-approve Thunderbolt device connection for every device, access to BIOS (UEFI) settings. In

Thunderbolt Options, select “PCle and Display Port - No Security”. Save changes and restart. Shown is
the HP BIOS settings example.

_

| UEFI Drivers |
|

Thunderbolt Options
= Display Language

= Scheduled Power-0On

¥ Thunderbolt Mode &
P PCle and DisplayPort - No Security
| e PeTe and DisplayPort = USE AJUTOITZa it
» System Options

« Built-In Device Options

= Port Options &

Thunderbolt Security Level

» Power Management Options

» Remote Management Options

« Electronic Labels
« MAC Address Pass Through

Remote HP PC Hardware Diagnostics
& Settings @
& Execute Remote HP PC Hardware Diagnostics &

KEYSIGHT
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11. Is Interconnect cables for LO or control
signals at VNA front panel properly?

 When “Self test failure: Sweep timeout” error message is shown in Host PC, check interconnect
cables for LO or control signal properly.

Ll et

Sel tests failed.

Solf tesl failure: Sweep tmisoul

I_;' |

1 VNA operation
of P5025B/26B/27B/28B or
of P5020B/P5021B/P5022B/P5023B/P5024B with Opt-402 &

KEYSIGHT
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FAQ

Q1: Do you know Host PC with Thunderbolt4 can communicate with P50xxB/P93xxB?

Al: Thunderbolt 4 is upward compatible with Thunderbolt 3.
It means without enhancing P50xxB/P93xxB firmware, Keysight expects PC with Thunderbolt 4 can communicate with
P50xxB/P93xxB.
Remember that some of PCs with Thunderbolt 3 cannot communicate with P50xxB/P93xxB, due to PCle resource conflict.
This situation of Thunderbolt 3 remains in using PC with Thunderbolt 4.

Q2: Do | require Thunderbolt 4 cable to communicate with Host PC with Thunderbolt 4 communication port?
A2: No, you don’t require Thunderbolt 4 cable. You can use Thunderbolt 3 cables which are recommended by Keysight.

You can use Thunderbolt 3 cables (ex. Y1701A-400 or 401) which are recommended by Keysight.
See Streamline VNA series config guide for more details.

Q3: Can | use a Thunderbolt to PCle adapter on the PC for the operation with P50xxB/P93xxB?

A4: Yes, use a Thunderbolt to PCle adapter which PC maker is recommended. See the compatibility list which have been
evaluated.

KEYSIGHT
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https://www.keysight.com/us/en/assets/3121-1254/configuration-guides/Streamline-Series-USB-Vector-Network-Analyzer-B-Models.pdf
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